
 

 

 

Getting Started Guide 
 

 

 
 
 
MemoCam®DVR 
MemoCam®DVR/S 



 

 

 

 

 

 

 

 

 

 

 

 

 

Version 3.2.002 

 



 

Copyright © Video Domain Technologies Ltd. 2003 

The information in this manual was accurate and reliable at the time of its release. However, Video Domain Technologies Ltd. reserves 
the right to change the specifications of the product described in this manual without notice at any time. As such, the descriptions and 
data included in this document may not be current. Video Domain Technologies Ltd. assumes no responsibility for any inconsistencies 
between the actual product and this manual's description of it. Any party electing to use this manual does so with the full knowledge of 
the possibility of such inconsistencies and takes full responsibility for any consequences that may arise while installing and/or using this 
product. 
Video Domain Technologies Ltd. holds the copyright to this manual. All rights are reserved. No part of this publication may be 
reproduced or transmitted in any form or by any means without prior written consent from Video Domain Technologies Ltd. 

Disclaimer 

Video Domain Technologies Ltd. make no warranties regarding the content of this document. Video Domain Technologies Ltd. reserves 
the right to alter, modify and revise the specification without notice. Video Domain Technologies Ltd. assumes no responsibility for any 
errors contained herein. 

The customer should note that in the field of multimedia there are a number of patents held by various parties. It is the responsibility of 
the user to assure that a particular implementation does not infringe on those patents. Video Domain Technologies Ltd. does not 
indemnify the user from any patent or intellectual property infringement. 

Registered Trademarks 

All other proprietary names mentioned in this manual are the trademarks of their respective owners. 

Video Domain Technologies Ltd. 
  

 



 

Manufacturer: Video Domain Technologies Ltd.  
Model: MemoCam    
Rated voltage(s): 12VDC 
Current(s) (or power): 0.4 A 

This device complies with Part 15 of the FCC Rules. 

Operation is subject to the following two conditions: 

(1)This device may not cause harmful interference, and 

(2) This device must accept any interference received, including interference that may cause undesired operation. 

This Class A/B digital apparatus complies with Canadian ICES-003. 

Cet appareil numẻrique de la classe A/B est conforme ả la norme NMB-003 du Canada. 

 FCC 

Changes or modifications not expressly approved by Video Domain could void the user’s authority to operate the equipment. 

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures: 
-- Reorient or relocate the receiving antenna. 
-- Increase the separation between the equipment and receiver. 
-- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
-- Consult the dealer or an experienced radio/TV technician for help. 
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Introduction 

Congratulations! You have chosen the 
MemoCam modular security solution.  

MemoCam is a modular solution that allows 
for economical system expansion and 
optimized use of existing equipment. With 
MemoCam, you can expand from a single unit 
to multiple sites and cameras. 

MemoCam is a configurable system solution 
for Video detection, CCTV monitoring, 
snapshot recording, and alarm triggering. 

MemoCam stores all images in a Multimedia 
Card. To analyze the recorded events on a PC, 
the Multimedia Card is removed from the 
MemoCam unit and images are downloaded 
using a Multimedia Card reader and the 
MemoCam software. 

One or more stand-alone units can be placed 
at different locations. The units are configured 
using the Multimedia Card. The MemoCam is 
activated using the remote control unit. 

 

 

Figure 1. The MemoCam System 

The MemoCam unit has the following features: 

� Automatic setup using the Multimedia 
Card. 
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� User defined image quality, frame rate, and 
recording time per event, delay between 
frames, and more 

� Fixed or cyclic recording modes 

� Pre-alarm recording 

� Image integrity protection 

� Arm/Disarm Scheduler 

� Video motion detection 

� Multi camera support 

� Video out 

� Remote control unit 

The MemoCam software allows you to: 

� View images as thumbnails or in a detailed 
list view. 

� Sort images by date and time. 

� View images for a specific period of time. 

� Play, pause, fast-forward, and rewind 
images. In addition, you can view images 
frame-by-frame or as a slide show 
playback. 

� Verify frame integrity. 

� Export to the built-in image editor. 

� Export to AVI. 

� Configure the MemoCam unit. 

� Print an image. 

The events recorded by the unit can be viewed 
on a PC with Windows 95, 98, 2000, ME, NT, 
or XP with Internet Explorer TM 5.0 (or higher), 
or a Pocket PC, with Windows CE 3.0 (or 
higher). The images are read from the 
MultiMedia card using a card reader and the 
MemoCam software. 
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Scope of this Guide 

This guide describes how to implement and 
install each of the following MemoCam series 
models: 

� MemoCam® DVR 

� MemoCam® DVR/S 

The MemoCam DVR is designed for easy 
integration into existing CCTV systems, and 
includes VMD, a video compression engine, a 
removable Multimedia Card, and supports up 
to three external cameras, an external monitor 
and external alarm devices. 

The MemoCam DVR/S provides the additional 
feature of a built-in serial port for serial 
communication.  

Package Contents 

The MemoCam Kit includes the following 
items:  

� MemoCam unit 

� Multimedia Card 

� Protective card cover 

� Power adapter 

� IR remote control unit and 2 AAA batteries 

� 2 video input cables 

� 1 video output cable 

� MemoCam Installation Manual 

� MemoCam Getting Started Guide (this 
guide) 

� MemoCam Software CD 

If items are missing, contact your local dealer. 
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See What MemoCam® DVR Can Capture 

 

Office and Warehouse 
See who opened the locked drawer in 
your office. 
View pictures of anyone who was around 
that valuable package that disappeared. 
See who came into the office after hours 
and what exactly they were doing there. 

 

Convenience and Retail Stores 
Replace the unreliable time-lapse VCR with 
the maintenance free MemoCam DVR. 
See who goes behind the counter and 
who reaches into the cashier drawer. 

 

Access Controlled Areas 
Verify that nobody but authorized 
personnel goes through that door.  
See which unauthorized people are 
entering. 

 

Home 
See if the babysitter is spending more time 
with her boyfriend than with your baby. 
Find out what the A/C technician was 
looking for in your bedroom chest of 
drawers. 
Determine what set off the alarm and why 
the police couldn’t find any entry marks. 

 

Managers 
Make sure employees do not punch the 
clock for each other by matching picture 
time with time punched on the card. 

 

Schools/Hotels/Hospitals 
See who’s been pushing drugs in the 
school halls. 
Get the picture of who walked out of the 
employees’ room with all their purses. 
See who opened the restricted medicine 
supply cabinet and removed prescription-
only drugs from it. 
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Setting Up MemoCam®DVR 

This section describes how to set up the 
MemoCam DVR unit before you begin using 
the unit. For more information, refer to the 
MemoCam Installation Manual. 

 For information about setting up the 
MemoCam DVR/S for serial communication 
with a host, refer to the MemoCam Installation 
Manual. 

Placing the MemoCam®DVR Unit 

It is recommended to install the 
MemoCam DVR in an indoor, dry, cool location.  

 

Figure 2. MemoCam DVR Unit – Front View  
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Figure 3. MemoCam DVR Unit – Rear View 

Connecting the External Camera 

To connect an external camera to the unit: 

1. Insert the connector from the external 
camera into the MemoCam DVR camera 
input connector (Figure 3).  

For instructions on how to connect up to two 
additional cameras, refer to the MemoCam 
Installation Manual. 

 All cameras connected to the MemoCam DVR 
must be the same standard, either CCIR or EIA. 
The unit automatically identifies the camera 
type when you turn the power on. 

The following are the minimum system 
requirements for cameras connected to the 
unit. 

Video Input 1Vpp 

Type CCIR (European) or EIA (USA) 

 For detailed information about installing the 
MemoCam DVR/S, refer to the MemoCam 
Installation Manual. 
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Connecting the Power Supply 

Connect the power adapter to the unit’s power 
connector (Figure 3). Plug the power adapter 
into a wall socket. The Power LED indicator 
lights red, as described in Table 1 on page 11. 

 The MemoCam DVR works only with the 
original, supplied, power adaptor.  

Accessing the Multimedia Card 

The simplest way to use the MemoCam DVR is 
by accessing the removable Multimedia Card. 
The card can transfer image data from the 
MemoCam unit to your computer, and 
configuration data from your computer to the 
MemoCam unit. The Multimedia Card can be 
used with any standard card reader. 

 To install the Multimedia Card reader on your 
computer, refer to the documentation supplied 
with the Multimedia Card reader. 

To access the Multimedia Card: 

1. MemoCam DVR comes with a protective 
cover over the Multimedia Card slot. 
Remove this cover before inserting or 
removing the Multimedia Card.  

2. To remove the Multimedia Card, push the 
card gently inward until you hear a click and 
then pull the card out of its slot. 

3. To reinsert the Multimedia Card, insert the 
card into the slot and push the card gently 
until you hear a click (refer to Figure 4 on 
page 8). Slowly release your finger from the 
card. Wait 3 or 4 seconds for the unit to 
read the card. 
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 When inserting the Multimedia Card, the side 
with the label should face toward you, as 
shown in Figure 4. 

 

Figure 4. Inserting the Multimedia Card 

 Verify that the unit is disarmed before 
removing the Multimedia Card. Refer to 
Disarming MemoCam®DVR on page 11. 

8  



 

Getting Acquainted 

The MemoCam DVR can be controlled by 
remote control or by the internal scheduler 
(refer to the MemoCam Software Manual for 
more details). 

Remote Control Unit 

The remote control unit is used to activate 
(arm), deactivate (disarm), and manually record 
image snapshots.  

 

Figure 5. Remote Control Unit 

As shown in Figure 5, the remote control unit 
has the following buttons: 

� Arm – Activates the MemoCam unit. When 
armed, the MemoCam unit will record a 
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series of images upon detection of 
movement. 

� Disarm – Deactivates the MemoCam unit. 
When disarmed, snapshots can be taken 
manually using the remote control unit. 

� Function – Reserved for future 
enhancements. 

� Rec – Triggers a snapshot to be stored in 
the Multimedia Card. 

� Digit buttons numbered 1, 2, 3, and 4 – 
Allows for Arm and Disarm Code entry. 

Remote control signals can be detected only 
from the front of the MemoCam unit. 

 Insert the two included AAA batteries into the 
remote control unit before use.  

Arming MemoCam®DVR  

To activate (arm) MemoCam DVR: 

1. Verify that the MemoCam unit is powered 
and the Multimedia Card is inserted into the 
unit. 

2. Point the remote control at the unit and 
press Arm (refer to Figure 5 on page 9). 
MemoCam emits one long beep and the 
Arm mode LED illuminates orange (refer to 
Figure 2 on page 5). 

 The system is preset so that no code is 
necessary to arm the MemoCam unit. However, 
you do have the option of selecting an arm 
code. For information about defining an arm 
code, refer to the MemoCam Software Manual. 
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Disarming MemoCam®DVR  

To deactivate (disarm) MemoCam DVR: 

1. Point the remote control unit at the 
MemoCam unit and enter the disarm code 
using the buttons labeled 1-4 on the remote 
control unit (refer to Figure 5 on page 9). 

2. Press Disarm (refer to Figure 5 on page 9). 
The MemoCam unit beeps three times and 
the Arm mode LED turns off. 

 The default disarm code is: 1234. To define a 
new disarm code, refer to the MemoCam 
Software Manual.  

LED Indicators 

As shown in Figure 2 on page 5, MemoCam 
DVR has the following LED indicators: 

Table 1. MemoCam LEDs 

LED Color Description 

Multimedia 
Card Status 
(left) 

Red Error or Multimedia 
Card is faulty or not 
inserted correctly 

 Blinking 
Green 

Data is being 
written to the 
Multimedia Card 

 Orange Multimedia Card is 
full 

Power (middle) Red Power is connected 

Arm mode 
(right) 

Orange MemoCam unit is 
in Arm mode 

 None MemoCam unit is 
in Disarm mode 

 All LED indicators except the power LED 
indicator can be enabled or disabled. Refer to 
the MemoCam Software Manual.  
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Audible Signals (Beeps) 

The MemoCam unit can be configured to emit 
an audible signal (beep) when: 

� You arm the unit – Long beep. 

� You enter a disarm code – Short beep after 
each button is pressed. 

� You disarm the unit – Two short beeps and 
one long beep. 

� In Disarm mode – A recurring short beep. 

� The Multimedia Card is not inserted – A 
recurring short beep. 

� The configuration is upgraded by inserting 
a Multimedia Card with an updated 
configuration – One short beep. 

� The configuration returns to the factory 
default – Three short beeps. 

 Audible signals can be enabled or disabled. 
Refer to the MemoCam Software Manual.  
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Installing MemoCam® Software 

Before you install the MemoCam software, 
make sure your computer or Pocket PC meets 
the following system requirements. 

PC Minimum Requirements 
CPU Pentium II 200MHz or higher 

RAM 16MB or higher 

Graphic adapter Super VGA or higher 

Display resolution 640x480, 32000 colors or 
higher 

Operating 
systems 

Windows 95, 98SE, ME, 2000, 
NT, or XP, with Internet 
ExplorerTM 5.0 or higher 

Multimedia Card 
Reader 

 

Pocket PC Minimum Requirements 
CPU ARM (or compatible) 

RAM 16MB or higher 

Display resolution 320x240, 32000 
colors/256 gray level or 
higher 

Operating systems Windows CE 3.0 or higher 

Multimedia Card 
Reader 
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Installing MemoCam® Software 
on Your PC 

Before beginning the installation, close all 
Windows programs you have running. 

 If you are using Windows NT, verify that the 
Active Desktop option in the display properties 
is ON. 

To install MemoCam software: 

1. Insert the MemoCam Software CD into the 
CD-ROM drive. The CD Browser screen 
appears automatically. If the CD Browser 
screen does not appear automatically, open 
Windows Explorer, browse to the CD-ROM 
drive, and double-click MCBrowse.exe. 

2. Click Install MemoCam. The Welcome screen 
appears. 

3. Click Next to continue with the installation. 
The License Agreement screen appears. 

4. Click Yes to accept the License Agreement 
terms. The Destination Location screen 
appears, indicating where the program will 
be installed. 

5. To change the folder location, click Browse. 
To continue, click Next. The MemoCam files 
are installed and the Setup Complete screen 
appears. 

6. You must restart your computer in order to 
use the newly installed program. Select the 
Restart option and click Finish. Your 
computer is automatically restarted. 

For more information, refer to the MemoCam 
Software Manual. 
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Installing MemoCam® Software 
on Your Pocket PC 

Before installing the MemoCam software for 
your Pocket PC, install and configure the 
MemoCam software on your PC. For 
information on installing the MemoCam 
software on your Pocket PC, refer to the 
MemoCam® Pocket PC Player User Guide.  

 To install the Multimedia Card reader on your 
computer, refer to the documentation supplied 
with the Multimedia Card reader. 
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Viewing the Images 

This section describes how to view 
MemoCam DVR images. For detailed 
information about all of MemoCam’s many 
features, refer to the MemoCam Software 
Manual. 

To view the recorded images: 

  If you are using a MemoCam DVR/S unit that is 
connected directly to your computer through 
the serial port, proceed to Step 4. 

1. Disarm the MemoCam unit (refer to 
Disarming MemoCam®DVR on page 11). 

2. Remove the Multimedia Card from the 
MemoCam unit (refer to Accessing the 
Multimedia Card on page 7). 

3. Insert the Multimedia Card into the card 
reader attached to your computer or Pocket 
PC. 

4. Click  on your desktop to open the 
MemoCam software. The MemoCam 
window opens, displaying thumbnails of 
the images stored on the Multimedia Card 
(refer to Figure 6 on page 17). 

 If there is no Multimedia Card in the reader, 
the MemoCam software opens a file 
containing sample images. 
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Viewing the Image List 

You can view the Image List displayed in the 
MemoCam window in either of the following 
ways: 

� As thumbnails of the images (Figure 6).  
To display the Image List as thumbnails, 
click  or open the View menu and 
select Thumbnails. 

� As a detailed list (Figure 8 on page 18).  
To display the Image List as a detailed list, 
click  or open the View menu and 
select Details.  

For more information, refer to the MemoCam 
Software Manual. 

If you are using a PC, the thumbnails view 
appears as shown in Figure 6. 

 

Figure 6. Thumbnails View – PC 
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If you are using a Pocket PC, the thumbnails 
view appears as shown in Figure 7. 

 

Figure 7. Thumbnails View – Pocket PC 

If you are using a PC, the detailed list view 
appears as shown in Figure 8. 

 

Figure 8. Detailed List View – PC 
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If you are using a Pocket PC, the detailed list 
view appears as shown in Figure 9. 

 

Figure 9. Detailed List View – Pocket PC 

Playing the Images 

You can view images consecutively in the 
MemoCam Image Viewer. The images are 
played in the order they appear in the Image 
List. A toolbar to control the viewing of images 
appears on the top of the window. 

To play images: 

1. Double-click an image in the list. 

OR 

1. Select an image in the list. 

2. Open the Edit menu and select Play. 
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Figure 10. Image in MemoCam Image Viewer 

The MemoCam Image Viewer toolbar contains 
the following buttons: 

Button Description 

 
Plays the images backward. 

Button Description 

 
Plays the images forward. 

 
Pauses the playing of images. 

 
Displays the current image in your 
PC’s default viewer. 

 
Displays the previous image. 

 
Displays the next image. 

 
Checks the image integrity. Enter the 
integrity key or load the key from a 
file. For more information, refer to 
the MemoCam Software Manual. 

 
Adjusts the speed at which 
the images are displayed. 
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Checking the System 

To check that the MemoCam unit was installed 
successfully and is operational: 

1. Make sure the Multimedia Card is inserted 
in the unit (refer to Accessing the 
Multimedia Card on page 7). 

2. Disarm MemoCam using the remote control 
unit (refer to Disarming MemoCam®DVR on 
page 11). 

3. Point the remote control unit at MemoCam 
and press Rec to record a snapshot. The 
Multimedia Card Status LED blinks green. 

4. Remove the Multimedia Card from the unit 
(refer to Accessing the Multimedia Card on 
page 7). 

5. Insert the Multimedia Card into the card 
reader attached to your computer or Pocket 
PC. 

6. View the image as described in Viewing the 
Images on page 16. 

If you encounter any problems during this 
process, refer to Troubleshooting in the 
MemoCam Installation Manual, or the 
MemoCam Software Manual. 

 The MemoCam unit has an internal clock. To 
configure the date and time, refer to the 
MemoCam Software Manual. 
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Glossary 

Arm Enables automatic detection and recording 
function. 

Cyclic 
Recording 

Continuous recording. The MemoCam 
records over older images from start of the 
cycle when Multimedia Card is full. 

Disarm Disables the automatic detection and 
recording function. 

Event The recording of one or more images as a 
result of a trigger. 

LED Light Emitting Diode. An electric component 
that lights up. 

Multimedia 
Card 

A stamp-sized plastic card containing 
read/write non-volatile memory.  

PIR Passive Infrared motion detector. 

Snapshot Recording of a single picture. 

Trigger A signal that activates the recording process. 
Usually generated by an alarm contact. 

VMD Video Motion Detection. A feature that 
detects changes in video frames. 

 

22  



 

License and Limited Warranty Agreement 
The opening of the packaging of the Software and/or the installation of the Software and/or the use of the Product shall be deemed that you have read and accepted the terms 
of this License and Limited Warranty Agreement. 
If you do not agree to the terms of this agreement, do not use the product. Promptly return the entire package to the place where you obtained it. 
General Terms 
You have purchased the right to use the software embedded in some integrated circuits of this Product and on the 
enclosed disks and/or CD_ROM (the ‘Software’) and you have purchased the hardware that is the other part of the 
Product (the ‘Hardware’), together (the ‘Product’) produced by Video Domain Technologies (‘VDT’). 
If the Hardware or the Software does not function properly, please return the Product, together with the copy of your 
paid receipt, to the place where you obtained it. 
License 
VDT grants you a license to use the Software subject to terms and conditions of the License agreement hereto. You 
do not own the Software. VDT and/or third parties remain the sole owner of the Software. The Software and 
accompanying documentation are proprietary products of VDT and/or third parties, and all title, trade secrets, trade 
names, trademark patents, copyrights and any other intellectual and proprietary rights, in the Product whether 
registered or not, remain the sole property of VDT and/or third parties. The intellectual property rights of VDT and/or 
third parties in the Product are protected by law. 
Your rights in the Software are limited to installation of the Software, in the machine-readable form in accordance 
with the instructions VDT provided you, executing the Software after installation, and making an archive copy(s) in 
the form provided for backup purposes. 
The Software may be used only in conjunction with the Hardware you bought, as an integral part of the Product. Any 
attempt to determine the source code for the Software; to modify, reprogram, translate, dissemble, decompose, or 
otherwise reverse engineer the Software; selling sublicense, transferring the Software to anyone else; or allowing any 
one the access or execute the Software through time sharing services or as a service bureau are forbidden. Any 
attempt to do any of these forbidden activities will automatically terminate your tight to use the Software and our 
Limited Warranty without any notice from use. 
Warranty 
The Product, including the media on which the Software is delivered, is warranted to be free of defects in material 
and workmanship and shall comply with VDT specifications, for a period of 12 months of normal use from the date 
of purchase (‘the Warranty Period’). 
The Warranty is void if VDT’s instructions of operation, checking and maintenance are ignored, if attempts to repair 
the Product have been done before the Product is returned to the place where you obtained it. Responsibility for 
normal wear and tear is excluded. 
The Product is provided ‘As Is’ and without Warranty, by VDT and/or the distributor and/or the importer, if the 
importer is not a distributor (each hereinafter the ‘Distributor’) of the Product, in the country where the product was 
purchased, or our suppliers, express or implied, including without limitation implied warranty of merchantability of 
fitness any particular purpose. 
During the Warranty Period, VDT’s and/or VDT’s Distributor sole obligation, in tort, contract, or otherwise, shall be to 
repair or replace the defective Product, at VDT’s option. The repair or replacement of the defective Product during the 
Warranty Period will not extend the Warranty Period. The Warranty does not cover failures resulting from improper 
operation, connection, or installation. 

For your convenience, VDT’s obligations in connection to Warranty claims, repairs service and instructions have been 
transferred to VDT’s Distributor in your country. The Distributor is responsible for providing you with all necessary 
services (If you need the details of the Distributor in your country, please contact VDT).  
However, if according to law, by law EC directive etc. prevailing in the country/state in which the product 
was purchased you are entitled a longer warranty period and/or to better minimum undertaking from VDT 
and/or from the distributor than those granted to you herein, then this document is changed to reflect the 
said minimum/s. 
Disclaimer 
VDT and/or the Distributor make no Warranty, Representation or promise expressed or implied that the Hardware 
and/or the Software or associated documentation will satisfy your requirements and/or that the hardware or software 
and documentation are without defect or error or that the operation of the hardware and software will 
uninterrupted or error free.   
Limitation of Liability 
Except as otherwise restricted by Law, VDT’s and/or distributor’s aggregate liability arising from or relating to your 
purchase and/or use of the Hardware and/or Software, the associated documentation or any services provided by VDT 
and/or the distributor, is limited to the total of all payments made by or for you for the Hardware and Software and 
documentation. 
Neither VDT nor the Distributor or any of their licensors, directors, employees, or any body acting on their behalf shall 
in any case be responsible or liable for any special, incidental, consequential, indirect or punitive damages, even if 
advised of the possibility of those damages and/or for lost profits or revenue, loss of contracts, loss of data, costs or 
re-creating lost data, and/or the cost of any substitute Hardware and/or Software and/or equipment or programs. 
Governing Law and Jurisdiction 
Except as otherwise restricted by law, this Agreement shall be governed only by, and interpreted, in accordance with 
the laws of the State of Israel and the exclusive jurisdiction shall be vested to the local courts of Tel Aviv. 

Entire Agreement 
This Agreement sets forth the entire understanding and rights and duties between you and VDT. This Agreement may 
be amended only in writing signed by both parties.  No person or entity is authorized to modify this Agreement or to 
make any warranty, representation or promise which is different than, or in addition to, the representation or 
promises of this   agreement. 
Waiver 
No waiver of any right under this Agreement shall be effective unless in writing, signed by a duly authorized 
representative of the party to be bound.  No waiver of any past or present right arising from any breach or failure to 
perform shall be deemed to be a waiver of any future right arising under this Agreement. 
Severability 
If any provision in this Agreement is invalid or unenforceable, that provision shall be construed, limited, modified or, if 
necessary, severed, to the extent necessary, to eliminate its invalidity or unenforceability, and the other provisions of 
this Agreement shall remain unaffected. 

                                                              PN/V7140025 
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